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Chapter

1
Introduction

Overview
The JRA Test Scoring System creates specialized psychological test reports, which are
intended to be used by licensed psychologists in conducting psychological evaluations of
applicants for police and other public safety positions.
Specialized selection reports can be created for six instruments, some of which have
multiple versions:
•

Personal History Questionnaire (PHQ)
o

PHQ-Required Explanations (PHQ-RE) (via online administration only)

•

California Psychological Inventory-434-Police and Public Safety Report (CPI-434-PPSR)

•

California Psychological Inventory-260-Police and Public Safety Report (CPI-260-PPSR) –
(Availability tentatively scheduled for end of year 2018)

•

Personality Assessment Inventory-Police and Public Safety Report (PAI-PPSR)

•

State-Trait Anger Expression Inventory-II-Police and Public Safety Report (STAXI-II-PPSR)

•

Psychological History Questionnaire (PsyQ)
o

PsyQ-Required Explanations (PsyQ-RE) (via online administration only)

The reports can be previewed on screen, printed from the JRA software, or exported to pdf.

A Typical Session
A typical session with the JRA Test Scoring System involves the following steps:
•
•
•
•
•
•
•

Collect test data (either by scanning test answer sheets, downloading data obtained from
online testing, or importing data files prepared previously) from one or more applicants.
Use the Data Editor to correct any errors or inconsistencies in the test data.
Enter the corrected data into the system's database, and display the individual test data
record(s) for each applicant, in the Data Viewer.
Demographic information for data records obtained through online administration may be
edited directly in the Data Viewer.
View, sort, and select some or all of the test data records in the Data Viewer.
Create test reports -- which can be previewed on screen, printed, or exported to pdf files -- for
each of the test data records you have selected.
Clear the test data records from the Data Viewer, archiving them and the associated reports in
the system's database.

The following other operations are occasionally done, as required:
•

Manage report authorizations (which are purchased credits allowing reports to be created).
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•
•
•
•
•
•
•
•

Set system options and retrieve selected data from the database back into the Data Viewer,
for additional processing.
Export selected test data records to raw files.
Delete selected test data records.
Update the software.
Manage a list of agency names and codes (for use in entering data and retrieving it from the
database).
Export summary report statistics.
Create summary reports for multiple test takers.
Export computed report statistics for analysis in statistics software such as SPSS.

Features
•
•

•
•
•
•

•
•
•

Reports for all tests can be previewed on screen, printed, or exported to pdf files.
Each report uses just one authorization, regardless of how many copies are made, what
formats are used (preview, print, or pdf) or what versions are produced (e.g., pre-offer or postoffer CPI, regular or background PsyQ). An exception to this general rule is the conversion of
a CPI-434 to a CPI-260. Doing so requires use of an additional authorization.
All data and reports are saved to a database, from which they can be retrieved as needed
Software is downloaded and upgraded from the Internet.
Report authorizations are downloaded from the Internet, and can be moved from one
computer to another.
Data editing tools can identify and correct inconsistencies in an applicant's personal
identification information (e.g., SSN, agency code, and test date) across different tests, which
facilitates research and the creation of multi-test reports
PsyQ and PHQ reports are in a new format that creates problem scores and compares them
to applicant norms.
The program runs under Microsoft Windows 7, 8, & 10.
The program uses an encrypted database to store data.

Compatibility with Previous JRA On-Site Scoring Software
The v2 Test Scoring System will run without conflicts on a computer that also has the JRA v1 test
scoring software installed. The old software can be kept as a backup capability until you are
comfortable using the new software.
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2
System Requirements

Operating System
The Test Scoring System has been tested with the following operating systems:
•

Windows 7, 8, & 10

Computer Requirements
•

At least 1 GHz minimum processor

•

At least 2 GB of RAM

•

At least 500 MB of disk space (1 GB minimum recommended)

Accessory Device Requirements
•
•

•
•
•

A Scantron Optical Mark Reader ("scanner") with 48 channel, double sided, pencil read
capabilities. Compatible scanners include the following Scantron models: 2250, 2260, 2500,
2800, and 8600, the iNSIGHT 4 ES, and the Opscan4ES, which is the only compatible model
currently sold by Scantron.).
o JRA Test Scoring System v2 is optimized for operation at 9600 baud. Prior to
installing your v2 software, check the baud rate of your scanner on v1 by
going to Tools->Options->Scanner. If your scanner is running at a different
baud rate, it is highly recommended that you change the baud rate of your
scanner. JRA will send out a config form to change the baud rate on your
scanner free of charge.
A serial port or a USB to serial conversion cable (such as the Keyspan USB to serial adaptor,
model USA-19HS) for older model scanners.
A windows compatible printer (if you want to create printed reports). For CPI, PAI, and STAXI
reports, the printing can be done somewhat faster if you have an HP laser jet printer.

Supplemental Software Requirements
In order for the JRA Test Scoring System to work properly, it is necessary that the following
program be installed on your computer. The installer will install it for you if it is not present on
your machine.
•

Microsoft .NET Framework 4.5.2
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Network capability
In addition to running on a standalone computer, the JRA Test Scoring System is also designed
to run on a network in a client server environment.

Internet Security Software Compatibility
The JRA Test Scoring System has been tested with the following products:
•
•
•
•

Microsoft Windows 7,8 & 10 Firewall
McAffee Antivirus Software Suite
Symantec Norton Internet Security Suite
ESET Security Suite

In some cases, it might be necessary to adjust settings in these products to ensure the best
possible performance with the Test Scoring System. If you think that you are experiencing a
conflict between the Test Scoring System and your Internet Security Software, please contact
JRA.
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3

Installing the JRA Test Scoring System
The JRA Test Scoring System software can be downloaded and installed, at no charge, from
the JRA website.
Before you start the installation process, we recommend that you exit all Windows programs, other
than your Internet browser. To start the download process, open an Internet Browser -- such as
Internet Explorer -- if you have not already done so. Then enter the following web address into
your browser: https://www.johnsonroberts.com/downloads/jrascoring.exe
If you are using Internet Explorer, clicking on this address will cause a menu to be displayed that
displays the standard security warning and asks whether you want to run or save the installation
program, which is contained in the file jrarpt_install.exe. Click on Run and the installation process
will begin.

Some browsers, such as Mozilla Firefox, do not display a run option, but rather ask you to save
the installation file to your computer. Google Chrome will open a window that asks, “Do you
want to allow this app to make changes to your device?” Click Yes.
** Please Note: During installation, the v2 software will check your system for the presence of
the supplemental software, Microsoft .NET 4.5.2., required for the JR&A Test Scoring System to
work properly. If this program is missing from your system, it will be installed automatically, with
no actions required of you.
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When the Install Wizard appears, click Next.
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Read the Important Information section and click Next.

Select a destination folder for your JRA v2 Test Scoring System, then click Next.
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Complete the Installation Wizard by clicking Next. Click Finish to complete the installation process.
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Starting and Ending the Program

To start the Test Scoring System from the Windows Start menu, do the following:
•

•
•
•

•

For older versions of Windows, click the Start button on the Windows taskbar, in the lower lefthand corner of the screen, then follow the steps below. Windows 10 users can simply type
JRA into the search bar and select it from there.
Select Programs from the Start menu and select JRA Test Scoring System v2 on the
continuation menu. This will display the program log in window.
Give permissions for any security screening windows, such as, “Do you want to allow this app
to make changes to your device?”.
NOTE: if you encounter an error when trying to run the JRA v2 for the first time, it may be
required that you right click the JRA program icon and select “Run as administrator” in order to
the necessary software permissions to be granted.
Enter your User ID and Password in the JRA Login window, and then click OK. This will
display the main screen of the Test Scoring System.

Note: Current JRA clients will be able to input their preestablished User ID and password. New
clients must establish an account, with User ID and password, with our production office. If
desired, the password can be changed after the first time you use the software.
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When the program begins, you will see the main screen of the Test Scoring System, which
contains the Data Viewer and the primary commands and menus of the Test Scoring System.

To end the Test Scoring System, click on the X in the upper right-hand corner of the main
screen.

Reset Button
The first time you log into the scoring system it verifies your log in credentials against the online
credentials we have established for you. Once that has happened the system stores your
Copyright © 2018 by JRA, Inc.
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credentials and validates them locally without connecting to the internet. If you change your online
credentials you will need to reset the scoring system login so that it uses those new credentials. If
you press the Reset button when the password has not been changed, nothing will happen.
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Data Collection

In This Chapter
•

Overview

•

Scanning test answer sheets

•

Inputting previously collected test data files

•

Downloading test data collected on the Internet

Overview
The first step in producing psychological test reports is to collect data containing the responses
that test takers have made to one or more tests. Test data can be collected either by scanning
paper and pencil answer sheets, downloading data obtained from online testing, or inputting data
files that have been prepared previously.

Scanning Test Answer Sheets
Scanning test answer sheets involves several steps, as described below.

Step 1 – Turn on the scanner
Turn on the scanner.
If you scan tests several times a day, it may be convenient to leave the scanner turned on
between scanning sessions.
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Step 2 – Start the JRA test scanning software
From the main menu, click File. From the drop-down menu, click Scan Test Answer Sheets, as
shown below.

Copyright © 2018 by JRA, Inc.

16
Co

Rev. 10/19/2018 for v2.77

Step 3 – Complete the Scan Test Answer Sheets Window
Before you start scanning, you must complete the Scan Test Answer Sheets window, in order to
provide information about the answer sheets that will be scanned.

First, you need to indicate whether you want to read the agency code from the scanned answer
sheets, or to assign the same agency code to each answer sheet read, regardless of what is on
the answer sheet. If you want to read the agency code from the scanned answer sheet, click the
box next to that option.
If all of the answer sheets are from the same agency, it is best to assign the same agency code to
each answer sheet so that any errors or omissions in completing the agency code on the answer
sheet are ignored. To assign the agency code to use for this purpose, click on the drop-down
menu in the agency window, then click on the name of the agency for which the testing was done.
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If the name of the agency for which the testing was done is not included in the drop-down menu,
you may need to add the agency name to the drop-down list. This can be done using the Agency
Codes tools.

Next you should specify a name for the batch of answer sheets you are scanning. This can be
anything that helps identify the batch, such as "Academy 202 Applicants". If you don't enter
anything in the window, the default batch name will be the date and time on which the scanning is
done. If you have already specified the agency for which the testing was done, knowing the date
and time is often a useful and sufficient way to identify the batch.
Finally, you should specify the set of test answer sheets that you will be scanning, by checking
the box next to the name of each test to be included in the scanning session. Later, after the data
is scanned, the Data Editor tool will check to see that all tests in the set have been scanned for
each test taker, and that the identification information for each test taker (name, social security
number, etc.) is consistent across all of the tests in the set. The Data Editor is discussed later, in
Chapter 6.
When you have finished completing the Scan Test Answer Sheets window, it will look something
like the figure below.
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Note: If a set of answer sheets for a group of test takers includes more than one test type, there
are advantages to scanning and editing all of answer sheets together. One is the simple
convenience of scanning all of the answer sheets for the group in a single session. Another is that
it makes it possible to check that the identification data for each test taker is consistent across
test types. This is useful for several purposes. It makes the reports for different tests consistent
with each other and makes it possible to create composite reports that are based on multiple
tests for a given test taker. It also helps keep accurate records of the testing that you have done,
and makes it easier to use the test data for research.
The disadvantage of scanning and editing more than one test type at a time is that it complicates
the data editing process a bit. If you want to avoid this complication, you can choose to enter and
edit the data for only one test at a time.

Step 4 – Download the test form definitions to the scanner
In order to convert the marks on the various test answer sheets into digital data, the scanner must
receive information about what the test answer sheets look like and how the marks on the answer
sheets should be interpreted. This information is called form definitions. The form definitions for
each of the five types of test answer sheets are included in the JRA Test Scoring System
software. These form definitions must be downloaded into the scanner before it scans test
answer sheets. The scanning software automatically does this, so click Yes when asked if you
want to download Form Definitions.
The scanner will retain the form definitions until it is turned off. Thus, if you do several scanning
sessions during the day, you can leave the scanner turned on, and only download the form
definitions the first time you scan each day. You will need to download Form Definitions each
time you initialize the scanner. If you have downloaded Form Definitions since last turning the
scanner on, you can click No to skip the downloading step, which takes roughly 30 seconds.
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Step 5 – Feed answer sheets into the scanner
When the form definitions finish loading (or if you skip the loading step), a window will appear
instructing you to feed the answer sheets into the scanner.
Feed the test sheets through the scanner with the answer sheets in the direction indicated on
the scanner. OpScan 4 users will place test answer sheets face up and aligned left. As the
answer sheets are fed through the scanner, the screen will display messages describing the
answer sheets that are being read.
When all the sheets have been fed through the scanner, press the End button on the scanner.
(On most Scantron models, the End button is labeled "End", but on some models it is an
unlabeled blue button.) Sometimes you have to push the button several times until the light
goes off and the scanner dialogue box closes. When you press the End button, the data will be
entered into the Data Editor, which you can use to edit any errors and omissions that exist in
the scanned data. (The Data Editor is discussed in Chapter 6 of this User Guide.)
You may cancel a scanning session by clicking on CANCEL. You may wish to do this if you
discover that you are inadvertently scanning tests that have already been scanned, or if the
scanner is malfunctioning in some way. If you encounter any errors in the scanning process
it is recommended that you power cycle the scanner. Should this not solve the problem,
power cycle the scanner again and restart the JRA software. If the problem persists, please
call the JRA office.

Downloading test data collected on the Internet
A simple and growingly preferable alternative to collecting test responses using
scannable paper and pencil answer sheets, tests can be administered on the Internet.
Applicants view the questions and enter their answers on a computer screen, and the
data is stored via the JRA encrypted software.
Once test data has been collected online, it can be downloaded to the Test Scoring
System. To do this, use the File -> Download Online Test Data command, as
illustrated below. (Your computer must be online in order to do this.)
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This command will display the Download window. Enter your User ID and Password, and click on
Next. After you click Next to download, the data will be downloaded directly to the Data Viewer of
the Test Scoring System. Because online data is not subject to the omitted questions or
marking errors that occur with paper and pencil testing, it isn't necessary to correct the
data in the Data Editor portion of the program.
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The Data Editor

In This Chapter
•

Overview

•

The Data Editor Grid

•

Merging Test Sets

•

The Test Set Editor

•

Editing Test Taker ID Variables (Page 1)

•

Editing Test Item Variables (Page 2)

•

Saving Edited Data

Overview
NOTE: In v1 of our software, the Data Editor and its functions were critical to the use of
physical test answer sheets and a Scantron scanner for scoring tests. All JRA test
reports are now available via online administration and the Data Editor step is bypassed
when collected data in this manner.
The Data Editor allows you to examine test data that has been collected, to identify errors in the
test data, and to correct those errors (to the extent that it is possible to do so) before the data is
saved to the Test Scoring System database and made available for creating reports and other
processing.
When a group of test takers has taken multiple tests at the same time -- such as the CPI, PAI,
and PsyQ -- the Data Editor allows you to determine whether each test taker has data for each
test that has been administered, and whether the identification information for each test taker
(name, social security number, etc.) is consistent across all of the tests in the test set. If
inconsistencies are discovered, the Data Editor allows you to correct them.
The Data Editor also allows you to identify and correct errors in the responses to the test items for
each test.

The Data Editor Grid
When a batch of test data has been collected for one or more tests, the Data Editor displays
information about the test data in a grid, like a spreadsheet, that indicates which tests have been
taken by each test taker, and whether the test data contains errors.
The Data Editor tries to match all of the test data for each test taker and summarize it in a single
row of the grid. Sometimes, however, if the test taker does not provide consistent ID information
(SSN, agency code, and test date) along with each test, the matching cannot be done, and the
test data for the test taker may be listed on more than one row of the grid.
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The Data Editor Grid shown below contains data for several applicants who have completed the
CPI, PAI, and PsyQ.

The variables used to describe the information in the Data Editor Grid are described below:

•
•
•
•

•

•

Name: The test taker's name (Last Name, First Name, Middle Initial).
SSN (The test taker's social security number.)
Agency: The 5-digit code of the agency for which the test was taken.
Batch:
o The collective label given to a set of test data records that have been entered into
the Test
o Scoring System, for a group of test takers.
o You assign the batch label at the time you enter the data into the Test Scoring
System either by scanning test answer sheets (which will automatically batch by
date), opening an existing raw data file, or preparing an online testing session.
Save:
o A coded indicator of whether the test taker's data, as represented in the row of
the Data Editor, is sufficiently complete and consistent that it should be saved to
the Data Viewer of the Test Scoring System and used to create reports.
o If the data is satisfactory, the cell in the Save column will contain "OK". If not, the
cell will contain "X". An OK in this cell requires that (a) all tests that were
administered in the batch are represented in the row, and (b) you have reviewed
all errors and mismatches, made whatever corrections you could, and accepted
any errors and mismatches that remain. (Acceptance is indicated by clicking the
Accept button in the Test Set Editor, as described below). BEN! WE NEED TO BE
ABLE TO SEE ALL ERRORS, ONE PAGE, NOT THREE
Match:
o A coded indicator of whether a specified group of user identification variables -which are listed in the Test Set Editor, as described below -- have the same values
for every test completed by the test taker.
o If these conditions are met, the cell in the Match column will contain "OK". If these
conditions are not met, but you have accepted the mismatches that remain after
you have edited the data, the cell will contain "OK*". Otherwise the cell will
contain "X”
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CPI, PAI, STAXI, PHQ, PsyQ (The Data Editor Grid contains a separate column for each of the five
tests)
•
•

•
•

•

A coded indicator of whether the test represented by the column has been completed by the
test taker, and, if so, whether any of the test item values contain errors.
If the item values for a test contained no errors, or if all errors have been corrected, the cell
contains "OK". If the item values for a test contain errors that have not been corrected by
editing, but you have accepted the errors that remain, the cell will contain "OK*". If the item
values for a test contain errors that have not been corrected or accepted, the cell will contain
"X". If a test in the test set has not been completed by the test taker, the cell will contain "--".
If the test is not included in the set of tests that were administered in the batch, the cell will be
blank.
In the data editor grid shown in the figure above, only one of the unedited test sets -- for
applicant "George FFFFFFF" -- is ready to be saved without editing, as indicated by the OK in
the Save column.
The grid shows that the data for the first applicant listed -- Matthew AAAAAAAAA -- has some
identification variables that do not match for all of the tests, as indicated by the X in the Match
column. The data also contains errors in the CPI and PsyQ, as indicated by the X in columns
for those two tests.

Merging Test Sets
The Data Editor tries to match all of the test data for each test taker and summarize it in a single
row of the grid. Data records are assigned to the same row if they have the same social security
number and agency code, and if the test dates are within one year of each other. (If the test dates
are not valid, they are ignored for the purpose of matching.)
If the test taker does not provide consistent matching information (SSN, agency code, and test
date) along with each test, his test records cannot be matched, and the test data for the test taker
will be listed on more than one row of the grid. In such cases additional steps can be taken to
merge the data records.
One option is to merge the records manually. This requires that you identify records that you think
should be merged. For example, the Data Editor Grid shown in the figure above contains two
rows for the last test taker, Jason GGGGGG. The first row contains data for the PAI, but is
missing data for the CPI and PsyQ. The second row contains data for the CPI and PsyQ, but is
missing data for the PAI.
The screen shows two rows with the same test taker name each of which has a test missing. This
kind of situation can be identified by sorting the rows by test taker name, which is done by clicking
on the top of the name column.
Looking at the information in the two rows, it is apparent that the two rows were not combined
automatically by the Data Editor because the social security number for the PAI does not agree
with social security number for the CPI and PsyQ. In such a case the two records can be
manually merged after which the invalid social security number can be corrected.
To merge two or more rows in the Data Editor grid, you need to highlight the rows to be merged,
then click on the Manual Merge command.
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After merging, the records will be listed in the same row of the Data Editor grid, as shown below:

Once the test records are merged, you should do whatever additional editing is required in order
to eliminate any other errors or mismatches in the data records.
Note that if the social security number is valid for one test but not for the other, the Data Editor will
automatically assign the valid social security number to both tests. If for some reason you do not
think that the value assigned is appropriate, you are free to change it by entering a different value
in the bottom row of the Test Set screen. (Editing with the Test Set screen will be discussed
below.)
Another option for merging rows with missing tests is to use the Automatic Merge command. The
Automatic Merge command locates rows to merge using variations of the following search
methodology:
•

Gather all rows that have an invalid social security number (with missing digits) and at least
one missing test.

•

To find a match for the first row on the list, look through all other rows for a social security
number that matches a social security number in the first row. For instance 123-12-1234
would match the invalid 123-12-?234.

•

If a match is found, describe the rows to be matched and ask the user whether or not to carry
out the merge.
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If you merge rows using the Automatic Merge command, the row with the valid social security
number becomes the "master" row. In case the values of other variables disagree among the
merged tests, the value of the "master" row is assigned to data record for all of the tests. (This
assignment can be changed in the Test Set Editor.)
If the first merging procedure doesn't find matches for all of the rows with missing tests, the
search is repeated, using last name, rather than social security number, as the matching variable.
If the second merging procedure doesn't find matches for all of the rows with missing tests, the
search is repeated again, using first name as the matching variable.

The Test Set Editor
Any row in the Data Editor grid that does not have "OK" in the Save column needs to be edited -in order to review and correct, if possible, the errors and mismatches that exist -- before the data
is saved to the Test Scoring System database and used for creating test reports. The editing is
done in the Test Set Editor. Only one row of the Data Editor grid can be edited at a time.
To use the Test Set Editor, select the row of the grid that you want to edit, then either (a) double
click on the row or (b) click Edit on the Data Editor menu.
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Editing Test Taker ID Variables (Page 1)
The main screen of the Test Set Editor contains a set of variable values for each test that was
taken by the test taker. In addition, the Test Set Editor also contains a "consensus" set of variable
values that will apply to all of the tests when the data is saved.

The variables are called Page 1 variables, because the variables reflect information entered by
the test taker on the front page of the answer sheet for each test. The Page 1 variables are listed
below. Variables listed with an asterisk are coded values, which are edited using a drop down
menu.
•

Agency Code

•

Last name

•

First Name

•

MI

•

Social Security Number

•

Age

•

Test Date (mm/dd/yyyy)

•

Sex*

•

Height

•

Serial Number (from the answer sheet used to collect the test data)

•

Ethnicity*
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•

Job Category*

•

Education*

The Data Editor tool will identify any errors, missing values, or inconsistencies in these variables
and allow you to correct them. Errors or missing values are identified with red characters.
Inconsistencies in values over the different tests are identified with blue characters.
If all of the tests taken already have the same value for a variable, the Data Editor automatically
inserts that value as the consensus value. If the tests do not already have the same value for a
variable, you can select one of the values -- or a new value if this seems appropriate -- as the
consensus value. If none of the tests have a value for a variable, you can specify a consensus
value or leave the consensus value blank.
You can correct any errors or mismatches that exist, either by filling in an open window, or
selecting a value from a drop down menu, depending on the variable that is being corrected. With
one exception, the corrected value will be entered in the consensus cell for that variable. The
exception is the test date, which is allowed to be edited with different values, because it is
possible that the test taker could have taken different tests on different dates.
Once you have corrected any errors that exist in the Page 1 variables, you should correct any
errors that exist in the Page 2 variables, as discussed below.

Editing Test Item Variables (Page 2)
The Data Editor also allows you to identify and correct errors in the responses to the test items.
The test items are called Page 2 variables, because they are located on the second page of the
answer sheet for each test.
For each test that is represented in the Test Set Editor there is a Page 2 button, which indicates
the status of the Page 2 test items for that test. If the letters on the button are black, the test items
do not contain errors. If the letters on the button are red, the test items do contain errors, and
need to be edited.
The Test Set screen shown above, for applicant Matthew AAAAAAAA contains Page 2 errors for
the CPI and PsyQ, as indicated by the red Page 2 buttons in the rows for these tests.
If you click on a red Page 2 button, you will see a list of the test items that have errors.
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Test item errors from scanned data are of two types: multiple marks or no marks at all. Multiple
marks are usually caused by incomplete erasures. Unmarked items are usually the result of the
test taker not marking the item, but sometimes the item is marked too faintly to be read by the
scanner, but sufficiently clearly to be read by the person doing the data editing.
For each item that is listed as having an error, you need to check the test answer sheet to
determine whether the answer for the item is present and unambiguous. If the answer is present,
and the test taker's intent is clear, you can correct the error by clicking on the correct response for
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the item. Otherwise, you will need to leave the error uncorrected. The figure below indicates that
the responses to questions 88 and 242 were corrected, while the responses to the other
questions that contained errors were not corrected.

If you change your mind about an item correction you have made, you can either click on a
different response for the item, or you can clear the response selection for the item by clicking on
the item number.
If you are curious to see all of the test item responses for a test, click the Show All button in the
lower right corner of the screen.
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A screen like the one shown below will appear.

For some tests, like the PsyQ, because there isn't room on the screen to display all of the items,
the items are shown in groups. You can look at each group of items by clicking on the appropriate
index tab at the top of the page.
To return to the display that shows only the errors, click the Show Errors button in the lower right
corner of the screen.
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Once you have corrected all of the data errors that you are able to correct, clicking Accept on the
bottom of the screen will save these corrections and return you to the Test Set page. Clicking
Cancel will cancel any corrections you have made and also return you to the Test Set page.
Once you return to the Test Set page, the lettering on the Page 1 button will reflect the effects of
your editing, in the following ways:
•

If you have corrected all of the errors, and return to the Test Set page by clicking the Accept
button, the lettering on the Page 1 button will be changed to black.

•

If there were some errors that you were not able to correct, but you click the Accept button,
indicating that you are satisfied that you have corrected as many errors as possible, the
lettering on the Page 1 button will still be red, but the background of the button will be black, .

•

If you return to the Test Set page by clicking the Cancel button, the lettering on the Page 1
button will still be red.
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Once you have corrected and/or accepted the Page 2 errors for all tests, all of the Page 2 buttons
should either have a black font and white background (indicating that any errors have been
corrected) or a red font on a black background (indicating that some errors have not been
corrected, but the editing has been accepted).
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Once you have corrected all of the errors that you are able to correct, clicking the Accept button
will save your changes and return you to the Test Set page. Clicking the Cancel button will return
you to the Test Set page without saving your changes.
After you have corrected any errors or mismatches that you are able to correct in the Page 1 and
Page 2 variables, given the information that you have available, you can press Accept to accept
the edited version of the test data for the test taker. Once the data for the test is accepted, the
Test Set is closed. If the Test is reopened, the word "Accepted" is listed below the Page 1 and
Page 2 buttons.

Saving Edited Data
Once you have edited all of the test data records to your satisfaction, the Data Editor Grid should
contain "OK" in the Save column for all test takers, as illustrated in the figure below.
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You are now ready to save the edited data to the system database. The data will be displayed in
the Data Viewer, where it can be used to create test reports.
There are two commands that can be used to save the edited data. One command, Save OK
Test Sets, saves all test sets in the Data Editor Grid that have an OK in the Save column, which
means that (a) all tests that were administered in the batch are represented in the row, and (b)
you have reviewed all errors and mismatches, made whatever corrections you could, and have
accepted any errors and mismatches that remain. The other command, Save Selected Test Sets,
saves any test sets in the Data Editor that you have selected (which will be highlighted). This
command is ordinarily used if you want to save test data sets for which all errors have not been
corrected or accepted.

Once you have selected one of the commands, you will be asked to confirm your choice.
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Saving PHQ and PsyQ Data For Custom reports
There are a number of custom PHQ and PsyQ reports that have been developed for particular
agencies, and for other specialized purposes. Selecting a custom PHQ or PsyQ report is done using
the Options tool of the Test Scoring System, which is discussed in chapter 7 of this manual.
If you are saving PHQ or PsyQ data, and intend to create custom reports with this data, not that the
data is saved to the Data Viewer in this format. In order to change the PHQ or PsyQ report format, you
must select the new format in Tools->Options and thereafter regenerate the reports by highlighting the
data to be regenerated and selection File->Regenerate Reports.
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Chapter

7
JRA Software Options

Version 2 of the JRA Test Scoring System contains several new features that allow the software user
greater flexibility in customizing test reports. Under the General tab, the software user is now able to
customize the report output to only show the last 4 digits of the test taker’s social security number and/or
suppress any reporting for sex, ethnicity, age, height, and weight data.
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The options tab also now includes the ability to customize the types of profiles shown for the CPI and PAI,
and the ability to customize the displayed comparison groups for the CPI, PAI, and STAXI. The CPI and
PAI tabs allow the user to select which types of profiles are displayed for each respective report.
The profile options available for the CPI and PAI give the user the ability to select whether an Applicant or
Incumbent comparison group is used as the special norm group and whether to display this information
as computed T score statistics (as the v1 software did) or as a shaded bar profile showing the
comparison group mean in Community T score units, plus or minus one standard deviation. For more
information about these profile options, please refer to the CPI-434-PPSRv2 Technical Manual and PAIPPSRv2 Technical Manual, available on the JRA website.
In addition to profile viewing options, the CPI tab permits the user to display a pre-offer or post-offer
version of the CPI. The pre-offer version omits certain Risk Statements and scale scores that might be
considered “medical” under the ADA.
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The PAI options tab has the same profile display options as the CPI. In addition the profile viewing
options, the PAI now has the ability to print all item endorsements on a scale if it reaches the 95th
percentile (or the 5th percentile for Dom and Wrm). A user may wish to use this display option as it
enables the assessor to determine the source of scale elevations and/or take into account the effect of
any item mismarks or misunderstandings. See the PAI-PPSRv2 Technical Manual for additional
information.

An additional new feature available for the CPI, PAI, and STAXI is norm mapping. This allows a user to
select which comparison group is displayed when an applicant selects a given job class. This feature
allows the user to use their professional judgment to determine which special normative sample is used
for non-standard job classes. For example, an assessor may prefer to have “Other” select a
Communications Dispatcher comparison rather than the Police comparison group because in their
practice, Other is commonly selected by non-sworn, non-weapon carrying employees.
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CPI Norm Mapping:
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PAI Norm Mapping:
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STAXI Norm Mapping:

The PHQ options tab is very similar to the one displayed in version 1 of the JRA software. This tab allows
the user to select the desired config file, which dictates the output format of the report, as well as the
option to show the test taker’s required explanations, if available. For more information about the
Required Explanations feature of the PHQ and PsyQ, please see the JRA website.
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The options tab for the PsyQ allows the user to select the same options as the PHQ, but permits to user
to dictate which config file is used for a standard, post-offer, form of the PsyQ report or the pre-offer,
background, version.
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Chapter

8
Exporting Computed Statistics

Version 1 of the JRA software allowed the user to export test data, but this was limited to individual
item responses in a raw datafile. At the request of our customers, version 2 of the JRA Test Scoring
Software includes a feature to export computed report statistics (T scores) for use in statistical analysis
software. This feature is accessed by selection File->Export Data->Computed Report Statistics. The SPSS
Data button exports the computed statistics in a raw file at the chosen file directory. The SPSS
definitions button exports a listing of variable names and levels for use in the process of importing the
data into SPSS or another statistifal software package.
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Chapter

9

Importing JRA Test Scoring System Version 1 Data
The JRA Test Scoring System version 2 software has a feature that enables the user to migrate over all
data from the old version 1 software. This is accessed by selecting File->Import v1 Data.

Selecting this button brings up a dialog box that requests the user to select the v1 database file to be
imported. If the database file is not automatically selected, one can usually locate it at in the default JRA
software directory (C:\Documents and Settings\All Users\Application Data\JRA) with an *.mdf file
extension.
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If the file is not present, or you cannot locate the file directory, Windows may require administrator
access to be granted. If you are having trouble with this feature, please call the JRA office.
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